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Overview

Feather is the new development board from Adafruit, and like it's namesake it is thin, light, and lets you fly! We
designed Feather to be a new standard for portable microcontroller cores.

This is the Adafruit Feather MO Bluefruit - our take on an 'all-in-one' Cortex MO+ Arduino-compatible + Bluetooth Low
Energy with built in USB and battery charging. Its an Adafruit Feather MO with a BTLE module, ready to rock! We have
other boards in the Feather family, check'em out here (https://adafru.it/jAQ)

Bluetooth Low Energy is the hottest new low-power, 2.4GHz spectrum wireless protocol. In particular, its the only
wireless protocol that you can use with iOS without needing special certification and it's supported by all modern smart
phones. This makes it excellent for use in portable projects that will make use of an iOS or Android phone or tablet. It
also is supported in Mac OS X and Windows 8+

At the Feather MO's heart is an ATSAMD21G18 ARM Cortex MO processor, clocked at 48 MHz and at 3.3V logic, the
same one used in the new Arduino Zero (http://adafru.it/2843). This chip has a whopping 256K of FLASH (8x more than
the Atmega328 or 32u4) and 32K of RAM (16x as much)! This chip comes with built in USB so it has USB-to-Serial
program & debug capability built in with no need for an FTDI-like chip.
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To make it easy to use for portable projects, we added a connector for any of our 3.7V Lithium polymer batteries and
built in battery charging. You don't need a battery, it will run just fine straight from the micro USB connector. But, if you
do have a battery, you can take it on the go, then plug in the USB to recharge. The Feather will automatically switch
over to USB power when its available. We also tied the battery thru a divider to an analog pin, so you can measure and
monitor the battery voltage to detect when you need a recharge.

Here's some handy specs! Like all Feather MO's you get:

® Measures 2.0" x 0.9" x 0.28" (51mm x 23mm x 8mm) without headers soldered in
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Light as a (large?) feather - 5.7 grams

ATSAMD21G18 @ 48MHz with 3.3V logic/power

256KB of FLASH + 32KB of RAM

No EEPROM

3.3V regulator with 500mA peak current output

USB native support, comes with USB bootloader and serial port debugging
You also get tons of pins - 20 GPIO pins

Hardware Serial, hardware 12C, hardware SPI support

8 x PWM pins

10 x analog inputs

Built in 100mA lipoly charger with charging status indicator LED
Pin #13 red LED for general purpose blinking

Power/enable pin

4 mounting holes

Reset button
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The Feather MO Bluefruit uses the extra space left over to add our excellent Bluefruit BTLE module + two status
indicator LEDs
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The Power of Bluefruit LE

The Bluefruit LE module is an nRF51822 chipset from Nordic, programmed with multi-function code that can do quite a
lot! For most people, they'll be very happy to use the standard Nordic UART RX/TX connection profile. In this profile,
the Bluefruit acts as a data pipe, that can 'transparently' transmit back and forth from your iOS or Android device. You
can use our iOS App (https://adafru.it/iCi) or Android App (https://adafru.it/f4G), or write your own to communicate with
the UART service (https://adafru.it/iCF).

The board is capable of much more than just sending strings over the air! Thanks to an easy to learn AT command
set (https://adafru.it/iCG), you have full control over how the device behaves, including the ability to define and
manipulate your own GATT Services and Characteristics (https://adafru.it/iCH), or change the way that the device
advertises itself for other Bluetooth Low Energy devices to see. You can also use the AT commands to query the die
temperature, check the battery voltage, and more, check the connection RSSI or MAC address, and tons more. Really,
way too long to list here!

Use the Bluefruit App to get your project started

Using our BluefruitiOS App (https://adafru.it/iCi) or Android App (https://adafru.it/f4G), you can quickly get your project
prototyped by using your iOS or Android phone/tablet as a controller. We have a color picker (https://adafru.it/iCl),
quaternion/accelerometer/gyro/magnetometer or location (GPS) (https://adafru.it/iCl), and an 8-button control game
pad (https://adafru.it/iCl). This data can be read over BLE and piped into the ATSAMD chip for processing & control

You can do a lot more too!

® The Bluefruit can also act like an HID Keyboard (https://adafru.it/iOA) (for devices that support BLE HID)
Can become a BLE Heart Rate Monitor (https://adafru.it/iOB) (a standard profile for BLE) - you just need to add the
pulse-detection circuitry

® Turnitinto a UriBeacon (https://adafru.it/iOC), the Google standard for Bluetooth LE beacons. Just power it and
the 'Friend will bleep out a URL to any nearby devices with the UriBeacon app installed.

® Built in over-the-air bootloading capability so we can keep you updated with the hottest new
firmware (https://adafru.it/iOD). Use any Android or iOS device to get updates and install them. This will update
the native code on the BLE module, to add new wireless capabilities, not program the ATmega chip.

Comes fully assembled and tested, with a USB bootloader that lets you quickly use it with the Arduino IDE. We also
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toss in some header so you can solder it in and plug into a solderless breadboard. Lipoly battery, breadboard and
USB cable not included (but we do have lots of options in the shop if you'd like!)
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The Feather MO Bluefruit is chock-full of microcontroller goodness. There's also a lot of pins and ports. We'll take you a
tour of them now!
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GND - this is the common ground for all power and logic

BAT - this is the positive voltage to/from the JST jack for the optional Lipoly battery
USB - this is the positive voltage to/from the micro USB jack if connected

EN - this is the 3.3V regulator's enable pin. It's pulled up, so connect to ground to disable the 3.3V regulator
3V - this is the output from the 3.3V regulator, it can supply 500mA peak

This is the general purpose I/O pin set for the microcontroller.

All logic is 3.3V
Nearly all pins can do PWM output
All pins can be interrupt inputs

® #0/RX - GPIO #0, also receive (input) pin for Serial1 (hardware UART), also can be analog input

® #1/TX-GPIO #1, also transmit (output) pin for Serial1, also can be analog input
® #20/SDA - GPIO #20, also the 12C (Wire) data pin. There's no pull up on this pin by default so when using with

12C, you may need a 2.2K-10K pullup.

® #21/SCL - GPIO #21, also the 12C (Wire) clock pin. There's no pull up on this pin by default so when using with

12C, you may need a 2.2K-10K pullup.
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® #5-GPIO #5

® #6-GPIO #6

® #9 - GPIO #9, also analog input A7. This analog input is connected to a voltage divider for the lipoly battery so be

aware that this pin naturally 'sits' at around 2VDC due to the resistor divider

#10 - GPIO #10

#11 - GPIO #11

#12 - GPIO #12

#13 - GPIO #13 and is connected to the red LED next to the USB jack

AO - This pin is analog input AO but is also an analog output due to having a DAC (digital-to-analog converter).

You can set the raw voltage to anything from 0 to 3.3V, unlike PWM outputs this is a true analog output

A1thru A5 - These are each analog input as well as digital I/O pins.

® SCK/MOSI/MISO (GPIO 24/23/22)- These are the hardware SPI pins, you can use them as everyday GPIO pins
(but recommend keeping them free as they are best used for hardware SPI connections for high speed and are
shared with the BLE)

Bluefruit LE Module + Indicator LEDs

Since not all pins can be brought out to breakouts, due to the small size of the Feather, we use these to control the
BLE module

® #8 - used as the Bluefruit CS (chip select) pin
® #7 - used as the Bluefruit IRQ (interrupt request) pin.
® #4 - used as the Bluefruit Reset pin

Since these are not brought out there should be no risk of using them by accident!

Other Pins!

® RST - this is the Reset pin, tie to ground to manually reset the ATSAMD, as well as launch the bootloader
manually

® ARef - the analog reference pin. Normally the reference voltage is the same as the chip logic voltage (3.3V) but if
you need an alternative analog reference, connect it to this pin and select the external AREF in your firmware.
Can't go higher than 3.3V!

® DFU - this is the force-DFU (device firmware upgrade) pin for over-the-air updates to the Bluefruit module. You
probably don't need to use this but its available if you need to upgrade! Check out the DFU Bluefruit Upgrades
page for how to use it. Otherwise, keep it disconnected.
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SWD Pins

There's two sets of SWD pins. These are used for program/debug of the two processors on the Feather.
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The round pads on the right are for the ATSAMD21G18 (main processor). The rectangular pads to the left are for the
nrf51822 inside the BLE module.

You cannot connect these together to debug both at the same time!

Factory Reset

The (somewhat deceptively labeled) 'Reset' pad on the bottom of the PCB beside SWCLK and SWDIO is for Factory
Reset. Connecting this pad to GND at startup will perform a factory reset, erasing any config settings and may be useful
trying to recover a device in a faulty state. Be sure to remove the connection to GND after the first power cycle.
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Assembly 3% adafruit learning system

We ship Feathers fully tested but without headers attached - this gives you the most flexibility on choosing how to use
and configure your Feather

Header Options!

Before you go gung-ho on soldering, there's a few options to consider!

The first option is soldering in plain male headers, this
lets you plug in the Feather into a solderless breadboard
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Another option is to go with socket female headers. This
won't let you plug the Feather into a breadboard but it
will let you attach featherwings very easily
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We also have 'slim' versions of the female headers, that
are a little shorter and give a more compact shape

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-m0-bluefruit-le Page 20 of 223


https://learn.adafruit.com/assets/30197
https://learn.adafruit.com/assets/30198

Finally, there's the "Stacking Header" option. This one is
sort of the best-of-both-worlds. You get the ability to
plug into a solderless breadboard andplug a
featherwing on top. But its a little bulky

Soldering in Plain Headers

Prepare the header strip:
+ * Cut the strip to length if necessary. It will be easier to
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Add the breakout board:

Place the breakout board over the pins so that the short
pins poke through the breakout pads

++ 21 And Solder!

+ .« Be sure to solder all pins for reliable electrical contact.

: : : : (For tips on soldering, be sure to check out our Guide to
' 21! Excellent Soldering (https://adafru.it/aTk)).
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\ ~ Solder the other strip as well.
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You're done! Check your solder joints visually and
5 o continue onto the next steps
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Tape In Place
For sockets you'll want to tape them in place so when

you flip over the board they don't fall out
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Flip & Tack Solder

After flipping over, solder one or two points on each
strip, to 'tack' the header in place
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And Solder!

Be sure to solder all pins for reliable electrical contact.

(For tips on soldering, be sure to check out our Guide to

Excellent Soldering (https://adafru.it/aTk)).
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You're done! Check your solder joints visually and
continue onto the next steps
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Power
Management

Battery + USB Power

We wanted to make the Feather easy to power both when connected to a computer as well as via battery. There's two
ways to power a Feather. You can connect with a MicroUSB cable (just plug into the jack) and the Feather will regulate
the 5V USB down to 3.3V. You can also connect a 4.2/3.7V Lithium Polymer (Lipo/Lipoly) or Lithium lon (Lilon) battery
to the JST jack. This will let the Feather run on a rechargable battery. When the USB power is powered, it will
automatically switch over to USB for power, as well as start charging the battery (if attached) at 100mA. This happens
'hotswap' style so you can always keep the Lipoly connected as a 'backup' power that will only get used when USB

power is lost.
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The above shows the Micro USB jack (left), Lipoly JST jack (top left), as well as the 3.3V regulator and changeover
diode (just to the right of the JST jack) and the Lipoly charging circuitry (to the right of the Reset button). There's also a
CHG LED, which will light up while the battery is charging. This LED might also flicker if the battery is not connected.

The charge LED is automatically driven by the Lipoly charger circuit. It will try to detect a battery and is
expecting one to be attached. If there isn't one it may flicker once in a while when you use power because it's
trying to charge a (non-existant) battery. It's not harmful, and its totally normal!

Power supplies

You have a lot of power supply options herel We bring out the BAT pin, which is tied to the lipoly JST connector, as
well as USB which is the +5V from USB if connected. We also have the 3V pin which has the output from the 3.3V
regulator. We use a 500mA peak regulator. While you can get 500mA from it, you can't do it continuously from 5V as it
will overheat the regulator. It's fine for, say, powering an ESP8266 WiFi chip or XBee radio though, since the current
draw is 'spikey' & sporadic.

Measuring Battery

If you're running off of a battery, chances are you wanna know what the voltage is at! That way you can tell when the
battery needs recharging. Lipoly batteries are 'maxed out' at 4.2V and stick around 3.7V for much of the battery life,
then slowly sink down to 3.2V or so before the protection circuitry cuts it off. By measuring the voltage you can quickly
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tell when you're heading below 3.7V

To make this easy we stuck a double-100K resistor divider on the BAT pin, and connected it to D9 (a.k.a analog #7 A7).
You can read this pin's voltage, then double it, to get the battery voltage.

#define VBATPIN A7

float measuredvbat = analogRead(VBATPIN);

measuredvbat *= 2; // we divided by 2, so multiply back
measuredvbat *= 3.3; // Multiply by 3.3V, our reference voltage
measuredvbat /= 1024; // convert to voltage

Serial.print("VBat: " ); Serial.println(measuredvbat);

This voltage will 'float' at 4.2V when no battery is plugged in, due to the lipoly charger output, so its not a good way to
detect if a battery is plugged in or not (there is no simple way to detect if a battery is plugged in)

ENable pin

If you'd like to turn off the 3.3V regulator, you can do that with the EN(able) pin. Simply tie this pin to Ground and it will
disable the 3V regulator. The BAT and USB pins will still be powered

Alternative Power Options

The two primary ways for powering a feather are a 3.7/4.2V LiPo battery plugged into the JST portora USB power
cable.

If you need other ways to power the Feather, here's what we recommend:
® For permanent installations, a 5V 1A USB wall adapter (https://adafru.it/duP) will let you plug in a USB cable for
reliable power
® For mobile use, where you don't want a LiPoly, use a USB battery pack! (https://adafru.it/e2q)
® |f you have a higher voltage power supply, use a 5V buck converter (https://adafru.it/DHs) and wire it to a USB
cable's 5V and GND input (https://adafru.it/DHu)

Here's what you cannot do:

® Do not use alkaline or NiMH batteries and connect to the battery port - this will destroy the LiPoly charger and
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there's no way to disable the charger
® Do not use 7.4V RC batteries on the battery port - this will destroy the board

The Feather /s not designed for external power supplies - this is a design decision to make the board compact and low
cost. It is not recommended, but technically possible:

® Connect an external 3.3V power supply to the 3V and GND pins. Not recommended, this may cause unexpected
behavior and the EN pin will no longer. Also this doesn't provide power on BAT or USB and some
Feathers/Wings use those pins for high current usages. You may end up damaging your Feather.

® Connect an external 5V power supply to the USB and GND pins. Not recommended, this may cause unexpected

behavior when plugging in the USB port because you will be back-powering the USB port, which could confuse
or damage your computer.
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Arduino IDE Setup

The first thing you will need to do is to download the latest release of the Arduino IDE. You will need to be using
version 1.8 or higher for this guide

https://adafru.it/f1P

https://adafru.it/f1P

After you have downloaded and installed the latest version of Arduino IDE, you will need to start the IDE and navigate
to the Preferences menu. You can access it from the File menu in Windows or Linux, or the Arduino menu on OS X.

- .
9 Blink | Arduino 1.82 ESEE

Edit Sketch Tools Help

Mew Ctrl+M
Open... Ctrl+Q
Open Recent
Sketchbook
Examples
Close Ctrl+W
|| Save Ctrl+5
Save As... Ctrl+Shift+5
1 Page Setup  Cirl+Shift+P
| Print Ctrl+P
i e public domain

Preferences  Ctrl+Comma

Quit Ctrl+Q

= ToUTE T ICEOT I

A dialog will pop up just like the one shown below.
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@ Preferences
Sketchbook location:
/Users [todd/Documents /Arduino

Editor language: = System Default

Editor font size: 10 (requires restart of Arduino)

Show verbose output during: compilation upload
Compiler warnings: = None H
Display line numbers
v Verify code after upload

Use external editor

v/ Check for updates on startup

v Update sketch files to new extension on save (.pde -> .ino)

Vv Save when verifying or uploading

Proxy Settings

Server (HTTP): Port (HTTP): 8080
Server: (HTTPS) Port (HTTPS): 8443
Username: Password:

Additional Boards Manager URLs: |

More preferences can be edited directly in the file
/Users/todd/Library/Arduinol5/preferences.txt
(edit only when Arduino is not running)

Browse

¥ (requires restart of Arduino)

0K Cancel

We will be adding a URL to the new Additional Boards Manager URLs option. The list of URLs is comma separated,
and you will only have to add each URL once. New Adafruit boards and updates to existing boards will automatically be
picked up by the Board Manager each time it is opened. The URLs point to index files that the Board Manager uses to

build the list of available & installed boards.

To find the most up to date list of URLs you can add, you can visit the list of third party board URLs on the Arduino IDE
wiki (https://adafru.it/f7U). We will only need to add one URL to the IDE in this example, but you can add multiple URLS
by separating them with commas. Copy and paste the link below into the Additional Boards Manager URLs option in

the Arduino IDE preferences.

https://adafruit.github.io/arduino-board-index/package adafruit_index.json
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Settings | Network

Sketchbook location:

C:\UsersYadyada'\DropboxarduinoSketches
Editor language: :Sysbem Default - (requires restart of Arduino)

Editor font size: 12

Interface scale: Automatic | 100 5% (requires restart of Arduino)

Show verbose output during: compilation upload
Compiler warnings: :None -

[ Display line numbers i
[] Enable Code Folding

Verify code after upload

[7] Use external editor

Check for updates on startup

Update sketch files to new extension on save (.pde -= .ino)

Save when verifying or uploagi

Additional Boards Manager URLs:f| https://adafruit.com/package_adafruit_index.json b
H

More preferences can be edited directly in the file Enter a comma separated list of urI;|

C:\Users\adyada\AppData'Local\Wrduino 15\preferences. it (
(edit only when Arduino is not running) i

Here's a short description of each of the Adafruit supplied packages that will be available in the Board Manager when
you add the URL:

Adafruit AVR Boards - Includes support for Flora, Gemma, Feather 32u4, Trinket, & Trinket Pro.
Adafruit SAMD Boards - Includes support for Feather MO and M4, Metro MO and M4, ItsyBitsy MO and M4, Circuit
Playground Express, Gemma MO and Trinket MO

® Arduino Leonardo & Micro MIDI-USB - This adds MIDI over USB support for the Flora, Feather 32u4, Micro and
Leonardo using the arcore project (https://adafru.it/eSl).

If you have multiple boards you want to support, say ESP8266 and Adafruit, have both URLs in the text box separated
by a comma (,)

Once done click OK to save the new preference settings. Next we will look at installing boards with the Board
Manager.

Now continue to the next step to actually install the board support package!
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* adafruit learning system
Using with Arduino IDE

The Feather/Metro/Gemma/Trinket MO and M4 use an ATSAMD21 or ATSAMD51 chip, and you can pretty easily get it
working with the Arduino IDE. Most libraries (including the popular ones like NeoPixels and display) will work with the
MO and M4, especially devices & sensors that use 12C or SPI.

Now that you have added the appropriate URLs to the Arduino IDE preferences in the previous page, you can open the
Boards Manager by navigating to the Tools->Board menu.

File Edit Sketch [Tools| Help
Auto Format
Archive Sketch
Fix Encoding 8 Reload
1 weid setup Serial Menitor Ctrl+5Shift+ M

Ctrl+T

sketch_now27s

2 /) put y

3 Board: "Arduino/Genuine Uno" Boards Manager...

4

- y Port Arduino AVR Boards

& void loop Programmer: "USBtinyISP" Arduine Yiin

7/ put o " .

; put ¥ Burn Bootloader Arduine/Genuine Uno

: s Arduino Duemilanove or Diecimila

Once the Board Manager opens, click on the category drop down menu on the top left hand side of the window and
select All. You will then be able to select and install the boards supplied by the URLs added to the preferences.

|:| Remember you need SETUP the Arduino IDE to support our board packages - see the previous page on how

to add adafruit's URL to the preferences

Install SAMD Support

First up, install the latest Arduino SAMD Boards (version 1.6.11 or later)

You can type Arduino SAMD in the top search bar, then when you see the entry, click Install

(zo! Boards Ma

Type |&ll v] ‘E&'{er your seardh...

Arduino SAM Boards (32-bits ARM Cortex-M3) by Arduino version 1.6.6 INSTALLED
Boards included in this package:

Arduino Due.

Online hels

More info

m

Arduino SAMD Boards (22-bits ARM Cortex-M0+) by Arduino
Boards included in this package:

Arduino/Genuino Zero.

Online halp

More info

Intel i586 Boards by Intel
Boards included in this package:
Galileo.

More info
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Install Adafruit SAMD

Next you can install the Adafruit SAMD package to add the board file definitions

Make sure you have Type All selected to the left of the Filter your search... box

You can type Adafruit SAMD in the top search bar, then when you see the entry, clickInstall

'

| Type al w» | |Filter pour seardh...

Boards included in this package:

(FTDI). Adafruit Trinket 8MHz, Adafruit Trinket 16MH=.

Online help
More info

l Adafruit Flora, Adafruit Gemma 8MHz, Adafruit Bluefruit Micro, Adafruit Feather 32u4, Adafruit Metro, Adafruit Pro Trinket
5V/16MHz (USB), Adafruit Pro Trinket 3V/12MHz (USB), Adafruit Pro Trinket 5W/16MHz (FTDI), Adafruit Pro Trinket 3V/12MHz

Adafruit SAMD Boards by Adafruit
Boards included in this package:
Adafruit Feather MO.

Online help

More info

Leonardo & Micro MIDI-USB (arcore) by Ralf Kistner

HBoards included in this package:

Arduino Leonarde (MIDI), Arduino Leonardo (MIDI, iPad compatible), Arduino Micro (MIDI).
Online help.

More info

Even though in theory you don't need to - | recommend rebooting the IDE

Quit and reopen the Arduino IDE to ensure that all of the boards are properly installed. You should now be able to

select and upload to the new boards listed in the Tools->Board menu.
Select the matching board, the current options are:

Feather MO (for use with any Feather MO other than the Express)
Feather MO Express

Metro MO Express

Circuit Playground Express

Gemma MO

Trinket MO

ItsyBitsy MO

Hallowing MO

hacking only)

Metro M4 Express
ItsyBitsy M4 Express
Feather M4 Express
Trellis M4 Express

Grand Central M4 Express
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File Edit Sketch Help

Auto Format Crl+T
Archive Sketch
duuplsiae Fix Encoding & Reload
// Examplefdi Serial Monitor Ctrl+Shift«M | 2F £ 3?5“’-“5
// 18 a diach e mallPlotber Cerl+Shiftel | *F7479-
// For more o A
ety WiFi101 Firmware Updater Adafruit SAMD (32-bits ARM Cortex-M0+ and Cortex-M4) Boards
// Also requi Board: "Adafruit ItsyBitsy M4 (SAMDS1)" y Adafruit Feather MO
// Rdafruic N Port | Adafruit Feather M0 Express
b GetBoardini Adafruithl'!ztn?MO Express
S Adafruit Circuit Playground Express
Programmer: "USBtinyISP" ! Adafruit Gemma MO
#include <Ada) Burn Bootloader Adafruit Trinket M0
: : " Adafruit ItsyBitsy MO
#define NUM _LED 64 // Per strand, Total number of pixels is Adafruit plRkey
// Second argument to constructor is an optional &-byte pin J Adafruit Metro M4 (SAMDS1)
Install Drivers (Windows 7 & 8 Only)
When you plug in the board, you'll need to possibly install a driver
Click below to download our Driver Installer
https://adafru.it/ECO
https://adafru.it/ECO
Download and run the installer
r R
Cpening adafruit_drivers.exe g

You have chosen to open:
== adafruit_drivers.exe
which is: Binary File (13,6 MB)

from: https://github-cloud.s3.amazonaws.com

Would you like to save this file?

’ Save File ] L Cancel J

Run the installer! Since we bundle the SiLabs and FTDI drivers as well, you'll need to click through the license

© Adafruit Industries

-
* Adafruit Board Drfvem:Ecense Agreement = | —

Please review the license agreement before installing Adafruit board
drivers. If you accept all terms of the agreement, dick I Agree.

h’his program will allow you to install Windows drivers for i
hardware that Adafruit Industries produces. Please support U
Adafruit by purchasing hardware from:
<http://www.adafruit.com/>

Note you can uninstall any of the installed drivers by using
the Add/Remove Programs option in Control Panel (look for
the "Windows Driver Package' entries from Adafruit).

Cancel | Mullsoft Install System v3,0b3 I Agree
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Select which drivers you want to install, the defaults will set you up with just about every Adafruit board!

Chedk the board drivers below that you would like to install. Click install to

start the installation.

Select board drivers to install:

Feather 32u4, Feather M0, Feather MO Ex
Feather WICED
Trinket / Pro Trinket f Gemma (USBtinyISP)

] Arduine Gemma
] Feather HUZZAH ESPE266 (SiLabs CP210x]
] Metro 328 / Metro Mini 328 (FTDI VCP and

< i »

Cancel | Mullsaft Inskall Systermn w302, 1

Click Install to do the installin'

< Back | Install I

-~
s Adafruit Board Drivers: &:mpleted_élﬂﬂ

Completed

Show details |

Cancel | tullsoft Install System «3,0b3

< Back

Blink

Now you can upload your first blink sketch!

Plug in the MO or M4 board, and wait for it to be recognized by the OS (just takes a few seconds). It will create a
serial/COM port, you can now select it from the drop-down, it'll even be 'indicated' as
Trinket/Gemma/Metro/Feather/ItsyBitsy/Trellis!

A7 put your

}

wvoid loopi) {
A7 put your

Board: "Adafruit Feather..."
Port: "COMS2 (Adafruit ..."

Programmer: "AVRISP mkdl"

Burn Bootloader

(@ sketch_nov23a | Arduino 164 =)
File Edit Sketch Help
Auto Format Ctrl+T
Archive Sketch
Sketeh_nov2ag Fix Encoding & Reload
void setup{) Serial Monitor Ctrl+Shift+M i

Serial ports
ComML
v COMS2 (Adafruit Feather MO (Mative USE Port))
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Now load up the Blink example

// the setup function runs once when you press reset or power the board
void setup() {

// initialize digital pin 13 as an output.

pinMode (13, OUTPUT);
}

// the loop function runs over and over again forever
void loop() {
digitalWrite(13, HIGH); // turn the LED on (HIGH is the voltage level)

delay(1000); // wait for a second
digitalWrite(13, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

And click upload! That's it, you will be able to see the LED blink rate change as you adapt the delay() calls.

If you're using Trellis M4 Express, you can go to the next page cause there's no pin 13 LED - so you won't see it blink.
Still this is a good thing to test compile and upload!

|:| If you are having issues, make sure you selected the matching Board in the menu that matches the hardware

you have in your hand.

Successful Upload

If you have a successful upload, you'll get a bunch of red text that tells you that the device was found and it was
programmed, verified & reset

Adafruit Feather MO (Nati ) on COMSS

After uploading, you may see a message saying "Disk NotEjected Properly" about the ...BOOT drive. You can ignore
that message: it's an artifact of how the bootloader and uploading work.
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Compilation Issues

If you get an alert that looks like

Cannot run program "{runtime.tools.arm-none-eabi-gcc.path}\bin\arm-non-eabi-g++"

Make sure you have installed the Arduino SAMD boards package, you need both Arduino & Adafruit SAMD board

packages

Fm-none i imarm-none

{runtim

Adafruit Feather M

Manually bootloading

If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that crashes and doesn't auto-reboot

into the bootloader, click the RST button twice (like a double-click)to get back into the bootloader.

The red LED will pulse, so you know that its in bootloader mode.

Once it is in bootloader mode, you can select the newly created COM/Serial port and re-try uploading.

Auto Format Cirl+T
Archive Sketch

Fix Encoding & Reload

Serial Monitor Ctrl+Shift«M = board
Board: "Adafruit Feather M0 (MNative USE Port)" L3
Port L Serial ports

com

Programmer: "USBtinyISP" [
comi2

Burn Bootloader
f/ turn the LED on (HIGH is the volcoge =cvezr
/ wait for

// turn the

f by making the woltage LOW

COMI129 (Adafruit Feather MO (Mative USE Port])

You may need to go back and reselect the 'normal' USB serial port next time you want to use the normal upload.

Ubuntu & Linux Issue Fix

Follow the steps for installing Adafruit's udev rules on this page. (https://adafru.it/iOE)
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ﬁ adafruit learning system
Adapting Sketches to MO &
M4

The ATSAMD21 and 51 are very nice little chips, but fairly new as Arduino-compatible cores go. Most sketches &
libraries will work but here’s a collection of things we noticed.

The notes below cover a range of Adafruit MO and M4 boards, but not every rule will apply to every board (e.g. Trinket
and Gemma MO do not have ARef, so you can skip the Analog References notel).

Analog References

If you'd like to use the ARef pin for a non-3.3V analog reference, the code to use is analogReference(AR_EXTERNAL)
(it's AR_EXTERNAL not EXTERNAL)

Pin Outputs & Pullups

The old-style way of turning on a pin as an input with a pullup is to use

pinMode(pin, INPUT)
digitalWrite(pin, HIGH)

This is because the pullup-selection register on 8-bit AVR chips is the same as the output-selection register.
For MO & M4 boards, you can't do this anymore! Instead, use:
pinMode(pin, INPUT_PULLUP)

Code written this way still has the benefit of being backwards compatible with AVR. You don’t need separate versions
for the different board types.

Serial vs SerialUSB

99.9% of your existing Arduino sketches use Serial.print to debug and give output. For the Official Arduino SAMD/MO
core, this goes to the Serial5 port, which isn't exposed on the Feather. The USB port for the Official Arduino MO core is
called SerialUSB instead.

In the Adafruit MO/M4 Core, we fixed it so that Serial goes to USB so it will automatically work just fine.

However, on the off chance you are using the official Arduino SAMD core and notthe Adafruit version (which really,
we recommend you use our version because it’s been tuned to our boards), and you want your Serial prints and
reads to use the USB port, use SerialUSB instead of Serialin your sketch.

If you have existing sketches and code and you want them to work with the MO without a huge find-replace, put
#if defined(ARDUINO_SAMD_ZERO) && defined(SERIAL_PORT_USBVIRTUAL)
// Required for Serial on Zero based boards

#define Serial SERIAL_PORT_USBVIRTUAL
#endif

right above the first function definition in your code. For example:
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File Edit Sketch Tools Help

datecale §

1|// Simple date conversions and calculations

Lo »

I 3 |#include <Wire.h>

4 #include "RIClib.h"

& #if defined (ARDUINO_ARCH_SAMD)

7|/f for Zero, output cn USB Serial console, remove line below if using programming port to program the Zero!
8 #define Serial SerialUSB
9 #endif
11 |void showDate {const char* txt, const DateTimes dt) {
Serial.print(txt);

13 Serial.print{’ '):

AnalogWrite / PWM on Feather/Metro MO

After looking through the SAMD21 datasheet, we've found that some of the options listed in the multiplexer table don't
exist on the specific chip used in the Feather MO.

For all SAMD21 chips, there are two peripherals that can generate PWM signals: The Timer/Counter (TC) and
Timer/Counter for Control Applications (TCC). Each SAMD21 has multiple copies of each, called 'instances'.

Each TC instance has one count register, one control register, and two output channels. Either channel can be enabled
and disabled, and either channel can be inverted. The pins connected to a TC instance can output identical versions of

the same PWM waveform, or complementary waveforms.

Each TCC instance has a single count register, but multiple compare registers and output channels. There are options
for different kinds of waveform, interleaved switching, programmable dead time, and so on.

The biggest members of the SAMD21 family have five TC instances with two 'waveform output' (WO) channels, and
three TCC instances with eight WO channels:

e TC[0-4],WO[0-1]
e TCC[0-2],WO[0-7]

And those are the ones shown in the datasheet's multiplexer tables.

The SAMD21G used in the Feather MO only has three TC instances with two output channels, and three TCC instances
with eight output channels:

e TC[3-5],WO[0-1]
e TCC[0-2],WO[0-7]

Tracing the signals to the pins broken out on the Feather MO, the following pins can't do PWM at all:
® Analog pin A5

The following pins can be configured for PWM without any signal conflicts as long as the SPI, I12C, and UART pins keep
their protocol functions:

® Digital pins 5, 6, 9, 10, 11, 12, and 13
® Analog pins A3 and A4

If only the SPI pins keep their protocol functions, you can also do PWM on the following pins:
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® TX and SDA (Digital pins 1and 20)

analogWrite() PWM range

On AVR, if you set a pin's PWM with analogWrite(pin, 255) it will turn the pin fully HIGH. On the ARM cortex, it will set
it to be 255/256 so there will be very slim but still-existing pulses-to-OV. If you need the pin to be fully on, add test
code that checks if you are trying to analogWrite(pin, 255) and, instead, does a digitalWrite(pin, HIGH)

analogWrite() DAC on AO

If you are trying to use analogWrite() to control the DAC output on AO, make sure you do not have a line that sets the
pin to output. Remove. pinMode(A0, OUTPUT).

Missing header files

There might be code that uses libraries that are not supported by the MO core. For example if you have a line with

#include <util/delay.h>

you'll get an error that says

fatal error: util/delay.h: No such file or directory
#include <util/delay.h>

~

compilation terminated.
Error compiling.

In which case you can simply locate where the line is (the error will give you the file name and line number) and 'wrap
it" with #ifdef's so it looks like:

#1if !defined (ARDUINO ARCH SAM) && !defined (ARDUINO ARCH SAMD) && !'defined(ESP8266) &&
!defined (ARDUINO ARCH STM32F2)

#include <util/delay.h>

#endif

The above will also make sure that header file isn't included for other architectures

If the #include is in the arduino sketch itself, you can try just removing the line.

Bootloader Launching

For most other AVRs, clicking reset while plugged into USB will launch the bootloader manually, the bootloader will
time out after a few seconds. For the MO/M4, you'll need to double click the button. You will see a pulsing red LED to
let you know you're in bootloader mode. Once in that mode, it wont time out! Click reset again if you want to go back to
launching code.

Aligned Memory Access

This is a little less likely to happen to you but it happened to me! If you're used to 8-bit platforms, you can do this nice
thing where you can typecast variables around. e.g.

uint8_t mybuffer[4];
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float f = (float)mybuffer;

You can't be guaranteed that this will work on a 32-bit platform because mybuffer might not be aligned to a 2 or 4-byte
boundary. The ARM Cortex-MO can only directly access data on 16-bit boundaries (every 2 or 4 bytes). Trying to access
an odd-boundary byte (on a 1 or 3 byte location) will cause a Hard Fault and stop the MCU. Thankfully, there's an easy
work around ... just use memcpy!

uint8_t mybuffer[4];

float f;
memcpy(&f, mybuffer, 4)

Floating Point Conversion

Like the AVR Arduinos, the MO library does not have full support for converting floating point numbers to ASCII strings.
Functions like sprintf will not convert floating point. Fortunately, the standard AVR-LIBC library includes the dtostrf
function which can handle the conversion for you.

Unfortunately, the MO run-time library does not have dtostrf. You may see some references to using #include
<avr/dtostrf.h> to get dtostrf in your code. And while it will compile, it does not work.

Instead, check out this thread to find a working dtostrf function you can include in your code:

http://forum.arduino.cc/index.php?topic=368720.0 (https://adafru.it/IFS)

How Much RAM Available?

The ATSAMD21G18 has 32K of RAM, but you still might need to track it for some reason. You can do so with this handy
function:

extern "C" char *sbrk(int 1i);

int FreeRam () {

char stack dummy = 0;

return &stack dummy - sbrk(0);
}

Thx to http://forum.arduino.cc/index.php?topic=365830.msg2542879#msg2542879 (https://adafru.it/m6D) for the tip!

Storing data in FLASH

If you're used to AVR, you've probably used PROGMEM to let the compiler know you'd like to put a variable or string in
flash memory to save on RAM. On the ARM, its a little easier, simply add const before the variable name:

const char str[] = "My very long string";

That string is now in FLASH. You can manipulate the string just like RAM data, the compiler will automatically read from
FLASH so you dont need special progmem-knowledgeable functions.

You can verify where data is stored by printing out the address:
Serial.print("Address of str $"); Serial.printin((int)&str, HEX);

If the address is $2000000 or larger, its in SRAM. If the address is between $0000 and $3FFFF Then it is in FLASH
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Pretty-Printing out registers

There's a /ot of registers on the SAMD21, and you often are going through ASF or another framework to get to them.
So having a way to see exactly what's going on is handy. This library from drewfish will help a ton!

https://github.com/drewfish/arduino-ZeroRegs (https://adafru.it/Bet)

M4 Performance Options

As of version 1.4.0 of the Adafruit SAMD Boards package in the Arduino Boards Manager, some options are available
to wring extra performance out of M4-based devices. These are in the Tools menu.

Sketch WELLIEE Help

CPU Speed: "200 MHz (overclock)"

v 200 MHz (overclock)

All of these performance tweaks involve a degree of uncertainty. There’s no guarantee of improved performance in
any given project, and some may even be detrimental, failing to work in part or in whole. If you encounter trouble,
select the default performance settings and re-upload.

Here’s what you get and some issues you might encounter...

CPU Speed (overclocking)

This option lets you adjust the microcontroller core clock...the speed at which it processes instructions...beyond the
official datasheet specifications.

Manufacturers often rate speeds conservatively because such devices are marketed for harsh industrial environments...
if a system crashes, someone could lose a limb or worse. But most creative tasks are less critical and operate in more
comfortable settings, and we can push things a bit if we want more speed.

There is a small but nonzero chance of code locking up or failing to run entirely. If this happens, try dialing back the
speed by one notch and re-upload, see if it's more stable.

Much more likely, some code or libraries may not play well with the nonstandard CPU speed. For example, currently
the NeoPixel library assumes a 120 MHz CPU speed and won’t issue the correct data at other settings (this will be
worked on). Other libraries may exhibit similar problems, usually anything that strictly depends on CPU timing...you
might encounter problems with audio- or servo-related code depending how it’s written. If you encounter such code or
libraries, set the CPU speed to the default 120 MHz and re-upload.

Optimize
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There’s usually more than one way to solve a problem, some more resource-intensive than others. Since Arduino got
its start on resource-limited AVR microcontrollers, the C++ compiler has always aimed for the smallest compiled
program size. The “Optimize” menu gives some choices for the compiler to take different and often faster approaches,
at the expense of slightly larger program size...with the huge flash memory capacity of M4 devices, that’s rarely a
problem now.

The “Small” setting will compile your code like it always has in the past, aiming for the smallest compiled program size.

The “Fast” setting invokes various speed optimizations. The resulting program should produce the same results, is
slightly larger, and usually (but not always) noticably faster. It's worth a shot!

“Here be dragons” invokes some more intensive optimizations...code will be larger still, faster still, but there’s a
possibility these optimizations could cause unexpected behaviors. Some code may not work the same as before.
Hence the name. Maybe you’ll discover treasure here, or maybe you’ll sail right off the edge of the world.

Most code and libraries will continue to function regardless of the optimizer settings. If you do encounter problems,dial
it back one notch and re-upload.

Cache

This option allows a small collection of instructions and data to be accessed more quickly than from flash memory,
boosting performance. It's enabled by default and should work fine with all code and libraries. But if you encounter
some esoteric situation, the cache can be disabled, then recompile and upload.

Max SPI and Max QSPI

These should probably be left at their defaults. They’re present mostly for our own experiments and can cause
serious headaches.

Max SPI determines the clock source for the M4’s SPI peripherals. Under normal circumstances this allows transfers up
to 24 MHz, and should usually be left at that setting. But...if you're using write-only SPI devices (such as TFT or OLED
displays), this option lets you drive them faster (we’ve successfully used 60 MHz with some TFT screens). The caveat is,
if using any read/write devices (such as an SD card), this will not work at all...SP| reads absolutely max out at the default
24 MHz setting, and anything else will fail. Write = OK. Read = FAIL. This is true even if your code is using a lower
bitrate setting..just having the different clock source prevents SPI reads.

Max QSPI does similarly for the extra flash storage on M4 “Express” boards. Very few Arduino sketches access this
storage at all, let alone in a bandwidth-constrained context, so this will benefit next to nobody. Additionally, due to the
way clock dividers are selected, this will only provide some benefit when certain “CPU Speed” settings are active. Our
PyPortal Animated GIF Display (https://adafru.it/EKO) runs marginally better with it, if using the QSPI flash.

Enabling the Buck Converter on some M4 Boards

If you want to reduce power draw, some of our boards have an inductor so you can use the 1.8V buck converter instead
of the built in linear regulator. If the board does have an inductor (see the schematic) you can add the line SUPC-
>VREG.bit.SEL = 1; to your code to switch to it. Note it will make ADC/DAC reads a bit noisier so we don't use it by
default. You'll save “4mA (https://adafru.it/FOH).
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* adafruit learning system
Installing BLE Library

Install the Adafruit nRF51 BLE Library

In order to try out our demos, you'll need to download the Adafruit BLE library for the nRF51 based modules such as this
one (a.k.a. Adafruit_BluefruitLE_nRF51)

You can check out the code here at github, (https://adafru.it/f4V) but its likely easier to just download by clicking:
https://adafru.it/f4W
https://adafru.it/f4W

Rename the uncompressed folder Adafruit_BluefruitLE_nRF51 and check that the Adafruit_BluefruitLE_nRF51 folder
contains Adafruit_BLE.cpp and Adafruit_BLE.h (as well as a bunch of other files)

Place the Adafruit_BluefruitLE_nRF51 library folder your arduinosketchfolderl/libraries/ folder.
You may need to create the libraries subfolder if its your first library. Restart the IDE.

We also have a great tutorial on Arduino library installation at:
http://learn.adafruit.com/adafruit-all-about-arduino-libraries-install-use (https://adafru.it/aYM)

After restarting, check that you see the library folder with examples:

Adafruit_ 9DOF

Edit Sketch Tools Help Adafruit_ADS1015
Mew Ctrl+M Adafruit_ADXL345_U
Open Ctrl+0 Adafruit_AHRS
Sketchbook Adafruit_AM2315
— Adafruit_AS3935
Adafruit_BLEFirmata
Close Ctrl+ W AR EEERma
Adafruit_BLEModule_SPISlave
Save Ctrl+5 . .
Adafruit_BluefruitLE_nRF51 atcommand
Save As... Ctrl+5hift+5 .
Adafruit_BMPOES beacon
Upload Ctrl+U
preed e Adafruit BMPOBS_Unified bleuart
Uplead Using Programmer  Ctrl+5Shift+U Adafruit BMP183 factoryreset
Page Setup Ctrl+Shift+P Adafruit_BMP183_Unified heartratemonitor
Print Ctrl+P Adafruit_BNO055 hidkeyboard
Adafruit_CAP1188 -
Preferences Ctrl+ Comma oo o L uribeacon

Run first example

Lets begin with the beginner project, which we can use to do basic tests. To open the ATCommand sketch, click on
the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select atcommand:
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Adafruit AHRS »
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit BMP085_Unified »> beacon
Adafruit_BMP183_Unified_Library > bleuart
Adafruit_BNO055 > factoryreset
Adafruit_ CC3100 »> heartratemonitor
Adafruit DHT_Unified > hidkeyboard
Adafruit_DotStar » uribeacon
Adafruit_FONA_Library »

This will open up a new instance of the example in the IDE, as shown below:

- k!
atcommand | Arduine 1.6.4 R E@g
File Edit Sketch Tools Help

atcommand

Afile atcommand. ino
@author  hathach

m

Thizs example shows how to comnect to your Adafruit Blusfruit LE (nef£Sl82Z2) and do
gome basic AT commands to check commectivity, print out the version strings and let
|| Fou gend your own AT conmards!

#include <string.h>

#include <Arduino.h>

#include <SPI.h>

#if not defined (_VARTANT ARDUINO_DUE_X_)
#include <SoftwareSerial.h>

#endif

#include "Adafruit BELE.h"
#include "Adafruit BLE_HWSPI.h"
#include "Adafruit BluefruitLE TUART.h"

=

/4 IE you are using Software Serial....
/7 The following macros declare the pins used for 5W serial, you should
ff/ use these pins if you are commecting the UART Friend to an UNOD

#define BELUEFRUIT SWUART FxD_PIN 9 J/ Required for software serial!
|| 44 fim- DITEETHITT emmTanT TWm nTe in S Timemadamd Foa emEbemosn omand ol i
4| [T b

Arduine Uno ¢

|:| Don't upload the sketch yet! You will have to begin by changing the configuration.

Go to the second tab labeled BluefruitConfig.h and find these lines
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// SHARED SPI SETTINGS

[ e e e e e eeoooooo---o-o---
// The following macros declare the pins to use for HW and SW SPI communication.

// SCK, MISO and MOSI should be connected to the HW SPI pins on the Uno when

// using HW SPI. This should be used with nRF51822 based Bluefruit LE modules

// that use SPI (Bluefruit LE SPI Friend).

[/ e ooosooooooooooooooooooooooo-
#define BLUEFRUIT_SPI_CS 8

#define BLUEFRUIT_SPI_IRQ 7

#define BLUEFRUIT SPI RST 6 // Optional but recommended, set to -1 if unused

And change (if it isnt already) the last line to:

#define BLUEFRUIT SPI RST 4 // Optional but recommended, set to -1 if unused

(The Bluefruit Feather has the reset on digital #4 not #6)

Now go back to the main tab atcommand and look for this line of code

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit BluefruitLE SPI ble(BLUEFRUIT SPI CS, BLUEFRUIT SPI IRQ, BLUEFRUIT SPI RST);

Make sure that the second line is uncommented (it should be)

|:| OK now you can upload to the Bluefruit Feather!

If you're using Ubuntu 15.04 or other Linux distributions and run into errors attempting to upload a program to
|:| the board, scroll up to the Ubuntu and Linux issue fix in the previous section

Uploading to the Feather Bluefruit LE

It's pretty easy to upload, first up make sure you have Adafruit Feather MO selected on the boards dropdown

r = - - Arduinc Hobot Motor
sketch_nov23a | Arduino 1.6.4 Arduing G
rduino Gemma
File Edit Sketch |T Is| Hel,
re o ep Adafruit Feather boards
Cuiolionnat GnET Adafruit Feather
Archive Sketch
cketch noy23s renne SkEre Adafruit SAMD Boards
- i Fix Encoding & Reload
. peEneeding & Reos © | Adafruit Feather MO (Native USE Port)
vold setup() Serial Monitor Ctrl+ Shift+ M
S/ put your ESPE266 Modules
Board: "Adafruit Feather..." Generic ESPE266 Module
i ! Port: "COMS52 (Adafruit .." Adafruit HUZZAH ESPE266
roi ModeMCU 0.9 (ESP-12 Modul
vold leopi) | Programmer: "AVRISP mid” ode ( odule)
\| // put your NodeMCU 1.0 (ESP-12E Module)
Burn Bootloader
il . Olimex MOD-WIFI-ESP8266(-DEV)

Also, in the Ports menu, look for the port labeled as such:
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( sketch_nov23a | Arduino 1.6.4 = [ E [ |
File Edit Sketch Help
Auto Format Ctrl+T E
Archive Sketch
sketch_novi3z Fix Encoding & Reload n
vold setup() Serial Monitor Ctrl+ Shift+ M i
#f put your
Board: "Adafruit Feather..." L4
! Port: "COMS52 (Adafruit ..." ) Serial ports
'11 Ltoopt) { Programmer: "AVRISP mkII" [ comL
Afput your v COMS2 (Adafruit Feather MO (Mative USE Port))
Burn Bootloader
1 I

Now click the upload button on the Arduino IDE (orFile Menu -> Upload)

If all is good you will see Done Uploading in the status bar

F b I TR e
atcommand | Arduino 1.6.4 o

File Edit Sketch Tools Help

atcammand | BILERFUIE aRfioh

O = M 1 s L) Y =

.C.
10
11
12
13
14

15 Hirncloda Ahrdaina ko

rebuildin

Ad afruit Bluefruit b
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ve USBE Port) on COMSS

Compilation Issues

If you get an alert that looks like
Cannot run program "{runtime.tools.arm-none-eabi-gcc.path}\bin\arm-non-eabi-g++"

Make sure you have installed the Arduino SAMD boards package, you need both Arduino & Adafruit SAMD board
packages

Manually bootloading

If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that crashes and doesn't auto-reboot
into the bootloader, click the RST button twice (like a double-click)to get back into the bootloader.

The red LED will pulse, so you know that its in bootloader mode.

Once itis in bootloader mode, you can select the newly created COM/Serial port and re-try uploading.

( 22 sketch_nov27a | Arduino 1.6.3
File Edit Sketch Help

Auto Format Cirl+T F
Archive Sketch
Fix Encoding & Reload

sketch_nov27z

1// the set Serial Monitor Ctrl+Shift+M = board
2 id setug
3 initi Board: "Adafruit Feather M0 (Native USE Port)" 4
5 ° Port L Serial ports
B . oML
Programmer: "USBtinyISP"
comiz
Burn Bootloader
COM129 (Adafruit Feather MO (Native USE Port])

. HIGH): £/ turn the LED on (HIGH is the volcoge zovezr

) off by making the voltage LOW

You may need to go back and reselect the 'normal' USB serial port next time you want to use the normal upload.

Run the sketch

OK check again that the correct port is selected
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-
sketch_nov23a | Arduino 1.6.4 - = | =
File Edit Sketch Help
Auto Format Ctrl+T
Archive Sketch
skeich_nov23 Fix Encoding & Reload
void setup() Serial Monitor Ctrl+ Shift+ i
A7 put your
Board: "Adafruit Feather..." L4
! Port: "COM52 (Adafruit..." Serial ports
woi COomML
void loop() { Programmer: "AVRISP mkIl"
| A put your v' COMS2 (Adafruit Feather MO (MNative USE Port))
Burn Bootloader

' !
gl

Then open up the Serial console. You will see the following:

F ™
@ COMSS (Adafruit Bluefruit Mi [E=EE
. (Adafruit Bluefruit Micro) .

2dafruit Bluefruit AT Command Example
Initialising the Bluefruit LE module: OK!
Performing a factory reset:
AT+FACTORYRESET

<- 0K
ATE=0

<- OK
Requesting Bluefruit info:
BLESPIFRIEND
nRF51822 QFACALO
6992A797D32E2839
0.6.5
| |
0.6.5
Jul 1 2015
5110 &.0.0, 0.2

Autoscrol BothNL&CR  » | 115200 baud

This sketch starts by doing a factory reset, then querying the BLE radio for details. These details will be useful if you are

debugging the radio. If you see the information as above, you're working! (Note that the dates and version numbers
may vary)

AT command testing

Now you can try out some AT commands - check the rest of the learn guide for a full list. We'll just start with
AT+HWGETDIETEMP which will return the approximate ambient temperature of the BLE chipset
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.
COMSS (Adafruit Bluefruit Micro) Lol o

AT +HWGETDIETEMP

2dafruit Bluefruit AT Command Example

Initialising the Bluefruit LE module: OK!
Performing a factory reset:
AT+FACTORYRESET

<- 0K
ATE=0

<- 0K

Requesting Bluefruit info:
BLESPIFRIEND

nRF51822 QFACALO
B992AT9TD3I2E2E39

0.6.5

0.8.5

Jul 1 2015
5110 &.0.0, 0.2

Autoscroll

R
COMEB (Adafruit Bluefruit Micro] - h@ﬂg

Performing a factory reset: -
AT+FACTORYRESET

<- 0K
ATE=0

<- OK

Requesting Bluefruit info:
BLESPIFRIEND

nRF51822 QFACALQ
6992RA797D32E2E839

0.6.5

0.8.5

Jul 1 2015

5110 &.0.0, 0.2

m

i
W
1

Autoscrol BothNL&CR » | 115200 baud

OK now you know how to upload/test/communicate with your Feather MO Bluefruit. Next up we have a bunch of
tutorials who can follow for checking out the bluetooth le radio and apps.

For all the following examples, we share the same code between various modules sodon't forget to make sure
you have the RESET pin set to 4 in BluefruitConfig.h for each sketch before uploading, and that
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Hardware SPI mode is selected by checking for

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit BluefruitLE SPI ble(BLUEFRUIT SPI CS, BLUEFRUIT SPI IRQ, BLUEFRUIT SPI RST);
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ﬁ adafruit learning system
Configuration!

|:| Before you start uploading any of the example sketches, you'll need to CONFIGURE the Bluefruit interface -

there's a lot of options so pay close attention!

Which board do you have?

There's a few products under the Bluefruit name:

If you are using the Bluefruit LE Shield then you have an
SPI-connected NRF51822 module. You can use this with
Atmega328 (Arduino UNO or compatible), ATmega32u4
(Arduino Leonardo, compatible) or ATSAMD21 (Arduino
Zero, compatible) and possibly others.

Your pinouts are Hardware SPI,CS=8,IRQ=7,RST =4

Bluefruit Micro or Feather 32u4 Bluefruit
If you have a Bluefruit Micro or Feather 32u4 Bluefruit LE
0000000 0 . then you have an ATmega32u4 chip with Hardware SPI,

En e a4 ~10 g~ £ ™

el L B TR CS=8,IRQ=7,RST =4
F eathisr = -
Bluefrii s

adafruit
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Feather MO Bluefruit LE

If you have a Feather MO Bluefruit LE then you have an
ATSAMD21 chip with Hardware SPI, CS=8,IRQ =7,
RST=4

Bluefruit LE SPI Friend

If you have a stand-alone module, you have a bit of
flexibility with wiring however we strongly recommend
Hardware SPI, CS=8,IRQ=7,RST =4

You can use this with just about any microcontroller with

5 or 6 pins
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Bluefruit LE UART Friend or Flora BLE

If you have a stand-alone UART module you have some
flexibility with wiring. However we suggest hardware
UART if possible. You will likely need to use the flow
control CTS pin if you are not using hardware UART.
There's also a MODE pin

You can use this with just about any microcontroller with
at least 3 pins, but best used with a Hardware
Serial/lUART capable chip!

Configure the Pins Used

You'll want to check the Bluefruit Config to set up the pins you'll be using for UART or SPI

Each example sketch has a secondary tab with configuration details. You'll want to edit and save the sketch to your
own documents folder once set up.

-
atcommand | Ardui E@g

File Edit Sketch Tools Help

BluefruitConfig.h
J COMMON SETTINGS

»

I

/4 These settings are used in both 5W UART, HW UART and SPI mode

1 =
#define BUFSTZE 1z8 /4 Size of the read buffer for incoming data 1
#define VEREOSE_MODE true J/ If set to 'true' enables debug output

/4 SOFTWAEE UART SETTINGS
1
/4 The following macros declare the pins that will be used for '5W' serial.

/4 Tou should use this option if wou are comnecting the UART Friend to an UNO
I
#define BLUEFEUIT_SWUART FXD_PIN 9 J/f FRequired for software serial!

HAAFime DTTEERIITT SUITATT T TTH in B L N N
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Common settings:

You can set up how much RAM to set aside for a communication buffer and whether you want to have full debug
output. Debug output is 'noisy' on the serial console but is handy since you can see all communication between the
micro and the BLE

[/ m e e e e e e e e e e e e e e e e e e e e e e e eeoeo-o---------
// These settings are used in both SW UART, HW UART and SPI mode

/] mm e eeooooososo-o-o-----
#define BUFSIZE 128 // Size of the read buffer for incoming data
#define VERBOSE MODE true // If set to 'true' enables debug output

Software UART

If you are using Software UART, you can set up which pins are going to be used for RX, TX, and CTS flow control. Some
microcontrollers are limited on which pins can be used! Check the SoftwareSerial library documentation for more
details

// SOFTWARE UART SETTINGS

#define BLUEFRUIT SWUART RXD PIN 9 // Required for software serial!
#define BLUEFRUIT_SWUART_TXD PIN 10 // Required for software serial!
#define BLUEFRUIT UART CTS PIN 11  // Required for software serial!
#define BLUEFRUIT_UART_RTS_PIN -1 // Optional, set to -1 if unused

Hardware UART

If you have Hardware Serial, there's a 'name' for it, usually Seriall - you can set that up here:

// HARDWARE UART SETTINGS

#ifdef Seriall // this makes it not complain on compilation if there's no Seriall
#define BLUEFRUIT HWSERIAL NAME Seriall

#endif

Mode Pin

For both hardware and software serial, you will likely want to define the MODE pin. There's a few sketches that dont
use it, instead depending on commands to set/unset the mode. Its best to use the MODE pin if you have a GPIO to
spare!

#define BLUEFRUIT_UART_MODE_PIN 12 // Set to -1 if unused

SPI Pins

For both Hardware and Software SPI, you'll want to set the CS (chip select) line, IRQ (interrupt request) line and if you
have a pin to spare, RST (Reset)

// SHARED SPI SETTINGS

#define BLUEFRUIT SPI CS 8
#define BLUEFRUIT SPI IRQ 7
#define BLUEFRUIT SPI RST 4 // Optional but recommended, set to -1 if unused
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Software SPI Pins

If you don't have a hardware SPI port available, you can use any three pins...its a tad slower but very flexible

// SOFTWARE SPI SETTINGS

#define BLUEFRUIT_SPI_SCK 13
#define BLUEFRUIT_SPI_MISO 12
#define BLUEFRUIT_SPI_MOSI 11

|:| Refer to the table above to determine whether you have SPI or UART controlled Bluefruits!

Select the Serial Bus

Once you've configured your pin setup in the BluefruitConfig.h file, you can now check and adapt the example sketch.

The Adafruit_BluefruitLE_nRF51 library supports four different serial bus options, depending on the HW you are using:
SPI both hardware and software type, and UART both hardware and software type.

UART Based Boards (Bluefruit LE UART Friend & Flora BLE)

This is for Bluefruit LE UART Friend & Flora BLE boards. You can use either software serial or hardware serial. Hardware
serial is higher quality, and less risky with respect to losing data. However, you may not have hardware serial available!
Software serial does work just fine with flow-control and we do have that available at the cost of a single GPIO pin.

For software serial (Arduino Uno, Adafruit Metro) you should uncomment the software serial contructor below, and
make sure the other three options (hardware serial & SPI) are commented out.

// Create the bluefruit object, either software serial...uncomment these lines
SoftwareSerial bluefruitSS = SoftwareSerial(BLUEFRUIT SWUART TXD PIN, BLUEFRUIT SWUART RXD PIN);

Adafruit BluefruitLE UART ble(bluefruitSS, BLUEFRUIT UART MODE PIN,
BLUEFRUIT UART CTS PIN, BLUEFRUIT UART RTS PIN);

For boards that require hardware serial (Adafruit Flora, etc.), uncomment the hardware serial constructor, and make
sure the other three options are commented out

/* ...or hardware serial, which does not need the RTS/CTS pins. Uncomment this line */
Adafruit BluefruitLE UART ble(BLUEFRUIT HWSERIAL NAME, BLUEFRUIT UART MODE PIN);

SPI Based Boards (Bluefruit LE SPI Friend)

For SPI based boards, you should uncomment the hardware SPI constructor below, making sure the other constructors
are commented out:

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit BluefruitLE SPI ble(BLUEFRUIT SPI CS, BLUEFRUIT SPI IRQ, BLUEFRUIT SPI RST);

If for some reason you can't use HW SPI, you can switch to software mode to bit-bang the SPI transfers via the following
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constructor:

/* ...software SPI, using SCK/MOSI/MISO user-defined SPI pins and then user selected CS/IRQ/RST */
Adafruit BluefruitLE SPI ble(BLUEFRUIT SPI SCK, BLUEFRUIT SPI MISO,

BLUEFRUIT SPI MOSI, BLUEFRUIT SPI CS,

BLUEFRUIT SPI IRQ, BLUEFRUIT SPI RST);
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ﬁ adafruit learning system
ATCommand

The ATCommand example allows you to execute AT commands from your sketch, and see the results in the Serial
Monitor. This can be useful for debugging, or just testing different commands out to see how they work in the real
world. It's a good one to start with!

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE
and select atcommand:

Adafruit AHRS 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library » bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 3 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon
Adafruit_FONA_Library »

This will open up a new instance of the example in the IDE, as shown below:
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.
atcommand | Arduine 1.6.4 R — @M

File Edit Sketch Tools Help

atcommand

fEl
Afile atcommand. ino
@author  hathach

m

This exanple shows how to comnect to your Adafruit Blusfruit LE (nrf51822) and do
gome basic AT commands to check commectivity, print out the version strings and let
ywou send your own AT conmands!

*/

#include <string.h>

#include <Arduino.h>

#include <SPI.h>

#if not defined (_VARTANT_ARDUINO_DUE_X_)
#include <SoftwareSerial.h>

#endif

#include "Adafruit_ELE.h"
#include "Adafruit BLE_HWSPI.h"
#include "Adafruit BluefruitLE UART.h"

S4 TE you are using Software Serial....

/7 The following macros declare the pins used for 5W serial, you should

/7 usge these pins if you are connecting the UART Friend to an UNO

#define BLUEFRUIT SWUART RxD_FIN 9 J/ Required for software serial!

HAr£im- DITTRIITT CIMTART TWT TTH N {4 Timemaiand Eow e femroan sewd ol {

4| n +

Arduine Uno ¢

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI.
The default is hardware SPI

If using software or hardware Serial UART:

® This tutorial does not need to use the MODE pin, make sure you have the mode switch in CMD mode if you do
not configure & connect a MODE pin

® Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it!(The Flora has this
already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished,
open up the Serial Monitor via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner
is set to 115200:
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2% COM250 (Adafruit Florz

|

Adafruit Bluefruit AT Command Example

Initialising the Bluefruit LE module:
ATZ

<- 0K

QK!

Performing a factory reset:
AT+FACTORYRESET

<- 0K
ATE=0

<- RATE=0

QK

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACALQ
D5321F75475B19EE
0.6.2

0.68.2

Rpr 30 2015

5110 &.0.0, 0.2
Mok

Autoscroll

iNohneenmng -  i9600baud -

To send an AT command to the Bluefruit LE module, enter the command in the textbox at the top of the Serial Monitor
and click the Send button:

ATI Send

The response to the AT command will be displayed in the main part of the Serial Monitor. The response from 'ATI' is
shown below:
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r

/dev/cu.usbmodem1411131

_Send

BLE AT COMMAND EXAMPLE

Performing a factory reset: OK!
BLEFRIEND32

nRF51822 QFACAl@
DEB72C43325A171B

8.6.5

@.6.5

Apr 30 2015

5110 8.9.9, 0.2

AT = ATI

BLEFRIEND32
nRF51822 QFACA10
DEB72(43325A171B
9.6.5

8.6.5

Apr 30 2015

5110 8.9.9, 0.2
0K

AT =

Initialising the Bluefruit LE module: OK!

™ Autoscroll You've pressed Send b...

| No line ending

¢ | 115200 baud

You can do pretty much anything at this prompt, with the AT command set. Try AT+HELP to get a list of all commands,
and try out ones like AT*HWGETDIETEMP (get temperature at the nRF51822 die) and AT+HWRANDOM (generate a

random number)

-

COM250 (Adafruit Flora)

e

© Adafruit Industries
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OK

BLEFRIEND32
nRF31822 QFRCRI1O0
D5321F75475B198E
0.6.2

0.6.2

Apr 30 2015

5110 &.0.0, 0.2

AT > AT+HWRANDOM

<- (0xASR3DEF1

AT > AT+HWGETDIETEMF

Requesting Bluefruit info:

FY

Autoscroll

No line ending

~ 9600 baud
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ﬁ adafruit learning system
BLEUart

The BLEUart example sketch allows you to send and receive text data between the Arduino and a connected
Bluetooth Low Energy Central device on the other end (such as you mobile phone using the Adafruit Bluefruit LE
Connect application for Android (https://adafru.it/f4G) or iOS (https://adafru.it/f4H) in UART mode).

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE
and select bleuart_cmdmode:

Adafruit AHRS 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library » bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 3 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon
Adafruit_FONA_Library »

This will open up a new instance of the example in the IDE, as shown below:
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bleuart_cmdmode | Arduinc 1.6.4 i - E I

File Edit Sketch Tools Help

hleuart_cmdmode §

Bfile bleuart_cmdmode. ino
Fauthor hathach, ktown (Adafruit Industries)

m

Thizs demo will show you how to send and receive data in COMMAND mode | &)
(without needing to put the module into DATA mode or using the MODE pin)

"/

#include <string.h>

#include <Arduino.hs>

ginclude <5PI.h>

#include <SoftwareSerial.h>

#include "Adafruit BLE.L"
#include "Adafruit BLE_HWSFI.h"
#include "Adafruit BluefruitLE_UART.h"

/4 IE wou are using Software 3Jerial....
S/ The following macros declare the pins used for 3W serial, you should
// use these pins if you are commecting the UART Friend to |a.u jol

#define BLUEFEUIT SWUART FXD_PIN ] J// Becuired for software serial!
#define BELUEFRUIT_SWUART TxD_PIN 10 /4 Becquired for software serial!
#define BLUEFEUIT UART CTS_FPIN 11 // Required for software serial!
#define BELUEFRUIT_UART RTS_PIN -1 /4 Optional, set to -1 if unused

/¢ TE wou are using Hardware Serial
// The following macros declare the Serial port you are using. Uncomment this

P0 liamm i wmmar  manm mmsmam s damer dmlem DTE dmm T ommam el (M s man T man

4 | i | 3

Adafruit Flara on GOk

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI.
The default is hardware SPI

If using software or hardware Serial UART:

® This tutorial does not need to use the MODE pin, make sure you have the mode switch in CMD mode if you do
not configure & connect a MODE pin

® Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it!(The Flora has this
already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished,
open up the Serial Monitor via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner
is set to 115200:
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N
COM250 (Adafruit Flora) E=EER=C

2dafruit Bluefruit Command Mode Example -

Initialising the Bluefruit LE module: ATZ

<- Q0K
OK!
Performing a factory reset: AT+FACTORYRESET

<- 0K
ATE=0

<- ATE=0
0K
Requesting Bluefruit info:

m

BLEFRIEND32
nRF51822 QFRCA10
D5321F75475B198E
0.6.2

0.8.2

Epr 30 2015

5110 &.0.0, 0.2
0K

Please use Rdafruit Bluefruit LE app to connect in UART mode
Then Enter characters to send to Bluefruit

Autoscroll jNo line ending jSEUU baud =

Once you see the request, use the App to connect to the Bluefruit LE module in UART mode so you get the text box on
your phone

Any text that you type in the box at the top of the Serial Monitor will be sent to the connected phone, and any data
sent from the phone will be displayed in the serial monitor:
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You can see the incoming string here in the Adafruit Bluefruit LE Connect app below (iOS in this case):

© Adafruit Industries

COM250 (Adafruit Flora) ol o

|

<- OK
OK!
Performing a factory reset: AT+FACTORYRESET

<- 0K
ATE=0

<- ATE=0

0K

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACALQ
D5321F75475B192E
0.68.2

0.6.2

Epr 30 2015

5110 &.0.0, 0.2
0K

Please use Rdafruit Bluefruit LE app to connect in UART mode
Then Enter characters to send to Bluefruit

EE L L P L L )

[Send] Hello, Adafruit!

m

1

Autoscroll jNo line ending jSEUU baud

https://learn.adafruit.com/adafruit-feather-mO0-bluefruit-le
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Hello, Adafruit!

Why hello, Arduino! Send

1 1 1 1 1 11 1

€ & @

return

The response text ('Why hello, Arduino!’) can be seen below:
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COM250 (Adafruit FI_ E=EERTSC

| |[send ]

<- Q0K
OK!
Performing a factory reset: AT+FACTORYRESET

<- 0K
ATE=0

<- ATE=0
0K
Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACALO
D5321F75475B198E
0.6.2
0.68.2
Epr 30 2015
5110 2.0.0, 0.2
0K
|| Flease use Adafruit Bluefruit LE app to connect in UART mode
Then Enter characters to send to Bluefruit

EEE L RS S ST T L]

[Send] Hello, Rdafruit!
[Recw] Why hello, Arduino!

~

m

[¥] Autoscrol [Noline ending  + | | 9600 baud

5
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ﬁ adafruit learning system
HIDKeyboard

The HIDKeyboard example shows you how you can use the built-in HID keyboard AT commands to send keyboard
data to any BLE-enabled Android or iOS phone, or other device that supports BLE HID peripherals.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE
and select hidkeyboard:

Adafruit. AHRS 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified [ beacon
Adafruit_BMP183_Unified_Library » bleuart

Adafruit_ BNO055 2 factoryreset
Adafruit_CC3100 [ 2 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar » uribeacon
Adafruit_FONA_Library >

This will open up a new instance of the example in the IDE, as shown below:

'@ hidkeyboard | Arduino 1.6

File Edit Sketch Tools Help

hidkeyboard

vold setupivoid) -

Serial.begin(ll15200);
Serial.println(F{"ELE HID FEYEOARD EXAMPLE")):
Serial.println(F("-------—----—oooooommo o R

/* Initialise the module */
Serial.print{F("Initialising the BEluefruit LE module: "));

if | 'ble.begin() )

{
Serial.println( F("FAILED! (Check wyour wiring?)") ):
while (1) {}

}

Serial.println({ F("0E!") }:

m

/* Perform a factory reset to make sure everything is in a knowm state */
Serial.print(F("Performning a factory reset: ")); =
EXECUTE| ble.factoryReset{) ):

/% Digable command echo from Eluefruitc */
ble.echo(false);

/% Set ble command verbose */
ble.verbose (false);

J* Print Bluefruit information */
ble.infao();

4 1 | +

Arduino U
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Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI.
The default is hardware SPI

If using software or hardware Serial UART:

® This tutorial does not need to use the MODE pin, make sure you have the mode switch in CMD mode!
® Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it!(The Flora has this
already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished,
open up the Serial Monitor via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner
is set to 115200:
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COM250 (Adafruit Flora) E=NEERTCE
|l

[

Adafruit Bluefruit HID Keyboard Example — l

Initialising the Bluefruit LE module: I
ATZ

<- 0K

QK!

Performing a factory reset:
AT+FACTORYRESET

<- OK
ATE=0

<- RATE=0

QK

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACALQ
D5321F75475B19EE
0.6.2

0.68.2

Rpr 30 2015

5110 8.0.0, 0.2
QK

m

Setting device name to "Bluefruit Eeyboard':
AT+GAFDEVNAME=Bluefruit Keyboard

<— OK
Enable Keyboard Service:
AT+BleKeyboardEn=0n

<- 0K
Performing a 5W reset (service changes regquire a reset):
ATZ

<- 0K

Go to your phone's Bluetooth settings to pair your device
then open an application that accepts keyboard input

Enter the character(s) to send:
- \r for Enter

- \n for newline

- A\t for tab

- \b for backspace

keyboard > -

[¥] Autoscroll iNo line ending vj il:LSZI.’JU baud vi

To send keyboard data, type anything into the textbox at the top of the Serial Monitor and click the Send button.

Bonding the HID Keyboard

Before you can use the HID keyboard, you will need to 'bond' it to your phone or PC. The bonding process establishes
a permanent connection between the two devices, meaning that as soon as your phone or PC sees the Bluefruit LE
module again it will automatically connect.
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The exact procedures for bonding the keyboard will varying from one platform to another.

When you no longer need a bond, or wish to bond the Bluefruit LE module to another device, be sure to

delete the bonding information on the phone or PC, otherwise you may not be able to connect on a new
devicel

Android

To bond the keyboard on a Bluetooth Low Energy enabled Android device, go to the Settings application and click
the Bluetooth icon.

These screenshots are based on Android 5.0 running on a Nexus 7 2013. The exact appearance may vary
depending on your device and OS version.

Wireless & networks

¥  WiFi ®  Bluetooth

( Datausage s« More

Inside the Bluetooth setting panel you should see the Bluefruit LE module advertising itself as Bluefruit Keyboard
under the 'Available devices' list:

< Bluetooth

(0]}

Available devices e

R 69:CC:12:C6:2A:75
E  Bluefruit Keyboard
% 14:99:E2:05:29:CF
Nexus 7 is visible to nearby devices while Bluetooth Settings is open.
Tapping the device will start the bonding process, which should end with the Bluefruit Keyboard device being moved

to a new 'Paired devices' list with 'Connected' written underneath the device name:
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Paired devices

Bluefruit Keyboard e

Connected

To delete the bonding information, click the gear icon to the right of the device name and the click the Forget button:

Paired devices
Name

Bluefruit Keyboard

Use for

Input device

FORGET oK

i0S

To bond the keyboard on an iOS device, go to the Settings application on your phone, and click the Bluetooth menu
item.

The keyboard should appear under the OTHER DEVICES list:
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00000 Free = 15:27 7 0} .

< Settings Bluetooth

Bluetooth C

Now discoverable as “iPhone de Kevin”.

MY DEVICES

SONY:CMT-X5CD Not Connected (i)

OTHER DEVICES -,
Adafruit Bluefruit LE

To pair an Apple Watch with your iPhone, go to the Apple
Watch app.

Once the bonding process is complete the device will be moved to the MY DEVICES category, and you can start to
use the Bluefruit LE module as a keyboard:

MY DEVICES
Bluefruit Keyboard Connected @
SONY:CMT-X5CD Not Connected (i)

To unbond the device, click the 'info' icon and then select the Forget this Device option in the menu:
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{ Bluetooth Bluefruit Keyboard

OS X

Forget This Device

To bond the keyboard on an OS X device, go to the Bluetooth Preferences window and click the Pair button beside
the Bluefruit Keyboard device generated by this example sketch:

To unbond the device once it has been paired, click the small 'x' icon beside Bluefruit Keyboard:

© Adafruit Industries

Bluetooth: On
Turn Bluetooth Off

Now discoverable as

“Kevin's MacBook Pro”

Bluetooth

Devices

e Bluefruit Keyboard

Show Bluetooth in menu bar

[a

e

Pair

Advanced...

https://learn.adafruit.com/adafruit-feather-mO0-bluefruit-le
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e00 < G Blustooth [a o)
Devices 3
Bluefruit Keyboard
Connected
Bluetooth: On
Turn Bluetooth Off
Now discoverable as
“Kevin's MacBook Pro”
Show Bluetooth in menu bar Advanced... ?

... and then click the Remove button when the confirmation dialogue box pops up:

Are you sure you want to remove “Bluefruit Keyboard”?

You have to pair this device again if you want to use it later.

Cancel Remove
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ﬁ adafruit learning system
Controller

The Controller sketch allows you to turn your BLE-enabled iOS or Android device in a hand-held controller or an
external data source, taking advantage of the wealth of sensors on your phone or tablet.

You can take accelerometer or quaternion data from your phone, and push it out to your Arduino via BLE, or get the
latest GPS co-ordinates for your device without having to purchase (or power!) any external HW.

O